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2 1 Introduction 

1 Introduction 

1.1 About This Guide 
This document is intended for engineers responsible for building MOTOTRBO 
radio networks and programming two-way radios for end users. 

1.2 About TRBOnet Swift 
TRBOnet Swift is a family of hardware products by Neocom Software, Ltd 
designed for use in MOTOTRBO radio networks. The TRBOnet Swift family 
hardware is presented by RoIP gateways A100 and A200, option board ST002. 

1.3 Contacts 

Region Phone Email & Support 

EMEA +44 203 608 0598 info@trbonet.com — general and 
commercial inquiries 

support@trbonet.com — technical 
support 

https://trbonet.com/kb/ — online 
knowledge base  

Americas +1 872 222 8726 

APAC +61 28 607 8325 

 

mailto:info@trbonet.com
mailto:support@trbonet.com
https://trbonet.com/kb/
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2 Overview 

2.1 About TRBOnet Swift CPS 
TRBOnet Swift CPS is a configuration editor designed for programming 
MOTOTRBO GOB option boards and the TRBOnet Swift family electronic devices 
with Swift Event Logic on board. 
TRBOnet Swift CPS can work with configuration files and with configurations 
loaded from devices. In addition, it can update the device firmware, read device 
memory, and program devices with an extended configuration provided by 
Neocom Software, Ltd by customer request. 
The intuitive user interface serves to facilitate every step of device programming. 

• Automatic detection of a connected device 

TRBOnet Swift CPS can connect devices using the USB, LAN, or OTAP 
interface. Devices connected to USB are detected automatically. The 
number of connected devices is only limited by the number of USB ports 
available on the computer. 

• Device-specific settings only 

TRBOnet Swift CPS displays the configuration settings specific to a given 
type of device. Where possible, the recommended settings are set by 
default.  

• Event Logic defined by rules 

Rule Editor facilitates the process of building Event Logic rules from 
configurable components. This tool allows the user to create new rules 
from copies with minimum effort. 

• Sample configuration files 

TRBOnet Swift CPS comes with a set of sample configuration files for all 
supported devices. Sample configurations include the default device-
specific settings and demonstrate the use of rules for setting up various 
Event Logic features. Sample files can serve as a starting point for creating 
device configurations when other configuration sources are not available. 
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2.2 About Swift Event Logic 
TRBOnet Swift Event Logic is a unified programmable environment supported 
by TRBOnet Swift DT500, TRBOnet Swift ST002, and MOTOTRBO GOB. The basic 
configurable components of Swift Event Logic include events, conditions, and 
actions. 
Swift Event Logic extends the capabilities of a standard radio network by 
implementing special features such as Lone Worker, Man Down, No Movement, 
Crash Detect, Speed Limit, Telemetry, GeoRoaming, and GeoFencing. 

2.3 Software Requirements 
Category Requirements 

CPU Intel Core i5 

Memory 4 GB 

Display 1600x900 minimum resolution, 1920x1080 and higher resolution is 
recommended 

Additional Devices Speakers 

Supported OS Windows 10 (x64)/11 

Software .NET Framework 4.8 

2.4 Licensed Features 
TRBOnet Swift Event Logic features are available on terms of commercial 
licensing. The following table describes the licenses that you need to purchase 
and activate on your device to use particular features. 

Note: If a configuration uses commercial features, they do not work until the 
required license is purchased and activated on that device. 

License Description Related features 

Location 
Tracking 

This license enables getting GNSS 
and iBeacon data from the radio. 

Sending GNSS reports to TRBOnet 
Server, Speed Limit, GeoRoaming, 
Geofencing, etc. 

Personal Safety This license enables getting data 
from the G-meter. 

Man Down, No Movement, Crash 
Detect, etc. 

Voice Recording This license enables downloading 
voice call records and playing 
them back. 

Voice Recording 

 
The Lone Worker feature is enabled on a device when any of the above licenses 
is activated. 
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3 Installation and Upgrade 
The following table describes how to install, uninstall, upgrade, and load new 
firmware to your TRBOnet Swift CPS software. 

Notes: The distribution package for TRBOnet Swift CPS is available for 
download at www.trbonet.com. From the main page, go to Downloads 
and click Firmware. Click to download the latest version of Swift Utilities 
Pack. 
Before installing TRBOnet Swift CPS make sure that your computer 
meets the minimum software requirements. For more information, refer 
to section 2.3, Software Requirements (page 4). 

To install TRBOnet Swift CPS: 

• Double-click the TRBOnet Swift distribution file to run the TRBOnet Swift 
CPS setup wizard. Click Next. 

• Accept the terms of the license agreement. Click Next. 
• Click Install, then click Finish to exit the setup wizard. 

To uninstall TRBOnet Swift CPS from your computer: 

• Double-click the TRBOnet Swift distribution file to run the TRBOnet Swift 
CPS setup wizard. Click Next. 

• Select the Remove option. 
• Click Remove, then click Finish to exit the setup wizard. 

To upgrade TRBOnet Swift CPS to a newer version: 

• Install the new version on your computer as described above. 
Uninstalling the previous version of the product is not required. 

To load new firmware to TRBOnet Swift CPS: 

Note: The firmware for all supported devices is integrated in TRBOnet Swift 
CPS. When new firmware is issued, you can load it to TRBOnet Swift CPS 
without upgrading the software to the next version. 

• To load firmware to TRBOnet Swift CPS, open the SWU file. The firmware 
is unpacked and installed automatically. 

 

http://www.trbonet.com/
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4 Device Programming 
This section describes how to connect your hardware to a computer for 
programming, how to update firmware, and how to create or update a 
configuration on a connected device. 

4.1 Swift CPS Options 
• On the toolbar, click Tools > Options. 
• In the left pane, select Options > General. 

 

In the right pane, specify the following Swift CPS-related options: 
 Allow changing device firmware type 

Setting this option to ON will allow you to select the device mode 
when updating firmware on the device (see section 4.3,Firmware 
Update, step 5). 

 Language 
From the list, select the interface language. 

 Auto-expand pinout diagrams 
If you set this option to ON, useful pinout diagrams will be expanded 
at the bottom of the right pane when configuring device's 
Audio Settings and I/O Settings. 

 Select external audio player 
This is the full path to the TRBOnet audio player. If required, click the 
ellipsis button (…) and specify a different path for the audio player. 

 Disable debug mode for all modules 
Click this link to disable the Debug mode in all available modules. 
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4.2 Device Connection 
TRBOnet Swift CPS can communicate with supported hardware over USB, LAN, 
or OTA (Over the Air). To use a particular interface, launch TRBOnet Swift CPS, 
expand the Connection menu and choose the required option. 

 

The selected connection appears on the status bar, for example, "Connection: 
USB". 

USB connection 
A USB connection is recommended for programming any supported hardware. 
This connection does not require any settings. Just connect the programming 
cable to the device and to a USB port of your computer, then launch TRBOnet 
Swift CPS and work with the device. Use the programming cable supplied with 
your device or recommended for use by the manufacturer of the device. 

LAN connection 
A LAN connection can be used for programming any hardware that can be 
connected to an IP network. Your device must be powered and connected to the 
same LAN where TRBOnet Swift CPS is installed. A brand new device has the 
following default IP settings: 

• IP address: 192.168.0.[xxx] 
• Subnet mask: 255.255.255.0 
• Default gateway: 192.168.0.1 

You may need to adjust the IP settings of your computer accordingly. 

Over the Air connection 
An OTA connection is used for over-the-air programming of endpoint devices 
such as DT500 connected to a MOTOTRBO radio or an option board ST002 
installed into a MOTOTRBO radio. 

• On the Connection menu, select Over the Air, and go to 
Tools> Options > Connections. 
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• Specify the following OTA connection settings: 

Setting Description 

Gateway The gateway that can establish an IP connection with TRBOnet 
Swift CPS and that can communicate with the device over the air. 
Values: 

• TRBOnet Server 
• Swift IP Gate A100/A200 

IP address The IP address of the gateway selected above. 

Port The Forward Data service port of the TRBOnet Server (if selected 
above). Default: 4011 

To get the port number, launch the TRBOnet Enterprise (PLUS) 
Server application and select Radio Systems > Services in the left 
pane. Find the port number under the Forward Data service 
option. 

Note: Make sure that the Forward Data service option is 
selected. 

Response 
timeout 

The time period, in seconds, to wait for a response from the server 
side (TRBOnet Server, Swift IP Gate). 

4.3 Firmware Update 
Before you proceed to device programming, we recommend that you update the 
device firmware to the latest version using TRBOnet Swift CPS. 
If your device is already configured, the configuration will be cleared from the 
device memory after you update the firmware. To preserve the current 
configuration, save it to a file and reload it to the device after the firmware 
update. 

To update the firmware version: 

 Launch TRBOnet Swift CPS on your computer. 
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 Connect your device to the computer and point the connection type in the 
TRBOnet Swift CPS settings. For details, refer to section 4.2, Device 
Connection (page 6). 

 On the Device menu, click Read, or click the Read button on the toolbar. 
 In the Device Information pane, click Update Firmware. 
 In the Firmware update window, select your device connected through 

USB. 

 

Note: If TRBOnet Swift CPS cannot detect a USB device, the cause may be the 
hardware driver not found on your computer. For details, refer to the 
user manual provided for your device. 

 Open the Mode menu and click the preferred mode. 

Note: If the Mode menu is read-only, close the Firmware update window. 
Then open the Tools menu and click Options. Make sure that the 
Allow changing device firmware type option is set to ON. 

 In the Firmware update window, open the Update to menu and click the 
firmware version to which the device will be updated. You can select the 
latest version or roll back to an earlier version if required. 

 Click Update to start the firmware update. The progress bar shows the 
progress of the operation. 

4.4 Device Configuration 
This section describes how to how to work with configuration files as well as 
perform read and write operations on a device. 

4.4.1 Opening a Configuration File 
In TRBOnet Swift CPS, you cannot create a configuration file from scratch. 
Instead, you need to open an existing configuration file, make the required 
changes, and save the result to a file or load it to a connected device. 
You can open a configuration from a file, for instance, from a sample file installed 
with TRBOnet Swift CPS. Or, you can read a configuration file from a connected 
device. 
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To read a configuration from the device: 
• Connect a configured device to a computer. Select the connection type. 
• On the Device menu, click Read, or click the Read button on the toolbar. 
• (Optional) Specify the connection settings and click Read. 
• (Optional) If more than one connected device is detected, click the 

required device in the dialog box. Then click OK. 

To open an existing configuration file: 
• On the File menu, click Open. Navigate to the required folder and select 

the configuration file. Then click Open. 
• Double-click the SWR file in the folder. 
• Drag the SWR file and drop it within the TRBOnet Swift CPS window. 

To open a sample configuration file: 
• On the File menu, click Open Sample. 
• In the folder, click the sample file intended for your type of device. Click 

Open. 
TRBOnet Swift CPS displays each opened configuration on a separate page. The 
label of the page displays the name of the opened file or the device and the used 
connection. 
If you open multiple configurations, they appear each on a separate page. You 
can work with them in parallel. 

4.4.2 Updating a Configuration File 
An opened configuration appears on a separate page in the main window of 
TRBOnet Swift CPS. The left panel of the page displays the logical sections of the 
configuration. If you click a particular section, the right panel shows the related 
configuration settings. 
The Device section includes the general information such as the type of device 
(model), the firmware version, the last date when the configuration was updated 
on the device, and the statuses of all features that require a license. To learn how 
to apply a license, refer to section 5, Licensed Features (page 42) 
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Note: When you open a configuration file, the device information and the 
license information apply to the device whose configuration has been 
saved to the file. 

If a device has external interfaces (RS-232, GPS, GPRS, other), the Device section 
includes additional sub-sections to configure communication through each 
external interface. 
The Logic section includes the Swift Event Logic configuration settings such as 
report profiles, regions, modules, rules, and others. If a device does not support 
Swift Event Logic, the Logic section is hidden. To learn how to configure Swift 
Event Logic settings, refer to section 4.5, Swift Event Logic (page 12). 

4.4.3 Saving a Configuration File 
You can save an opened configuration to a file or load it to the memory of a 
connected device. If you just close the configuration page or the application 
window, you cancel all the changes without a prompt. 

To write a configuration to a connected device: 
• On the Device menu, click Write, or click the Write button on the toolbar. 
• (Optional) Specify the connection settings and click Write. 
• (Optional) If multiple connected devices are detected, point the required 

device in the dialog box. Click OK. 
• (Optional) If you write the configuration initially created for a different 

type of device, confirm the operation. 

Note: A configuration written to a different type of device includes all 
definitions from the Logic section of the left panel. Connection settings 
in the Device section are not written to a different type of device. 

To save a configuration to a file: 
• On the File menu, click Save As. 
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• Go to the required folder. Click an existing SWR file to be updated, or type 
the name of a new configuration file that will be created. Click Save. 

4.5 Swift Event Logic 
This section describes how to configure the Swift Event Logic settings on a 
device. 

4.5.1 Operations with Logic 
You can import and export the Logic section of a configuration using commands 
on the Logic > General page. 

 

Use these commands only when requested by the support team of the product 
vendor. In all other cases, manage the device configuration as described in 
section 4.4, Device Configuration (page 9). 

To save logic to XML file: 
• On the Logic > General page, click Save as xml in the right panel. 
• Go to the destination folder and save the file with the preferred name. 

To import logic from XML or SWR file: 
• On the Logic > General page, click Clear in the right panel. The Logic 

section now displays Logic information only. 
• Click Import logic. 
• In the system dialog box, select the type of file with the external logic – 

XML or SWR. Select the file and click Open. 
The logic imported from SWR is displayed in the Logic section. The logic 
imported from XML is not displayed, the Logic section only includes Logic 
information. 
The Logic information section shows the name of the source file. 
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4.5.2 Report Profiles 
If configured accordingly, a device can collect incoming information in the 
memory, create data sequences (reports), and send them to TRBOnet Server 
over a radio channel or via a Wi-Fi connection. Reports typically include the 
current location of a connected radio and telemetry from the input pins. 
To define rules for creating and sending reports, create a profile with report 
settings. You can create as many profiles as necessary. One profile must be 
indicated as default. The default profile is loaded to the device memory at 
startup. 
To configure report settings in an opened configuration, click Report Profiles in 
the Logic section of the navigation panel. 

 

The Report Profiles page displays general settings that will be applied in all 
report profiles. 

Report Options 
• Use protocol compatible with Enterprise 6.2 and newer 

Choose this option to use the protocol compatible with Enterprise 6.2 and 
newer versions. 

• Use protocol compatible with Enterprise 6.1 and older 
Choose this option to use the protocol compatible with Enterprise 6.1 and 
older versions. 

Note: Choosing this option will disable EGPS report profiles. 

• Synchronize time with server 
Select this checkbox so that the time on the radio will be synchronized 
with TRBOnet Server. 
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Report Settings 

Save GNSS data 
• Every … m 

The GNSS data will be saved to the report each time the specified distance 
(in meters) is traveled. 

• Every … sec 
The GNSS data will be saved to the report each time the specified time 
interval (in seconds) elapses. 

• When direction changes 
Select this option so that the GNSS data will be saved to the report each 
time the direction of travel changes. 

Note: This option affects only mobile radios. 

• Add speed and direction 
Select this option so that the GNSS data will be accompanied by speed 
and direction. 

Note: This option is unavailable when an EGPS CSBK report 
profile is present in the list of report profiles. 

• Add RSSI of repeater 
Select this option so that the GNSS data will be accompanied by RSSI level 
when the radio receives an incoming voice call via the repeater/control 
station. Note that if there are no incoming voice calls, the RSSI level won’t 
be added to the report. 

Note: This information can only be used in TRBOnet Watch v4.1 
(and higher) to evaluate radio signal quality depending 
on location and generate RSSI maps. 

Add optional data 
• Battery status 

Select this option so that the battery status will be included in each 
report. 

• Telemetry 
Select this option so that telemetry data will be included in each report. 

• Selected Tx group 
Select this option so that the Tx group selected on the radio be included 
in each report. 

Radio Network Settings 
• MOTOTRBO CAI 

The MOTOTRBO network identity (CAI) (be default, 12). 
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• TRBOnet Server ID 
The unique radio ID of TRBOnet Server in the MOTOTRBO network (by 
default, 64250). 

Note: For systems based on Control Stations or TRBOnet Swift 
Agents, enter the value of ‘Radio ID’. Check it in Control 
Radio’s configuration using Motorola CPS. 
Recommended value: 64250. 

 For IP Site Connect systems without NAI data, enter the 
value of ‘TRBOnet Radio ID’. Check it in connection 
settings of the IPSC system in TRBOnet. Recommended 
value: 64250. 

 For IP Site Connect, Capacity Plus Single Site, and 
Capacity Plus Multi Site systems with NAI Data with NAI 
data, enter the value of ‘MNIS Radio ID’. Check it in MNIS 
Data Gateway settings. 

 For Capacity Max systems, enter the value of ‘Data 
Gateway Radio ID’. Check it in Motorola RM, see MNIS 
Data Gateway. 

• TRBOnet Server port 
The port of the PC where TRBOnet Server is running (by default, 4104). 

Wi-Fi Network Settings 
• Device ID from radio 

Select this option so that the Device ID will be taken from the radio ID. 
• Device ID 

If the option above is unchecked, enter the Device ID of the radio. 
• TRBOnet Server IP 

The IP address of the PC where TRBOnet Server is running. 
• TRBOnet Server port 

The port of the PC where TRBOnet Server is running (by default, 4180). 

 Adding Report Profiles 
To add a report profile: 

• Click the plus sign icon on the right of the Report Profiles item, and from 
the drop-down list select the desired report profile. 
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You can add the following report profiles: 
• Radio Report profile 
• Wi-Fi Report profile 
• EGPS Report profile 
• EGPS CSBK Report profile 
• Report Disabled profile 

 

 Radio Report Profile 
This report profile is used to send periodic reports via MOTOTRBO digital voice 
or data channels in the following radio systems: Direct Channel, IP Site Connect, 
Capacity Plus Single Site, Capacity Plus Multi Site, and Capacity MAX. 
A single report contains up to 100 coordinate pairs (up to 60 pairs for TRBOnet 
Enterprise 6.1 and older). Please note that this maximum number may decrease 
due to the inclusion of additional data in the report, such as battery status, 
telemetry events, iBeacon location data, and more. 
It is recommended to send a report every 120 seconds. 

 

In the Radio Report page, specify the following options: 
• Send report every (m) 

The radio will send a report each time the specified distance (in meters) is 
traveled. 

• Send report every (sec) 
The radio will send a report each time the specified time interval (in 
seconds) elapses. 

• Send report when it is ready 
Select this option so that a report will be sent as soon as it is ready. 
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• Number of retries 
Enter the number of retries for sending a report on the radio channel. 

• Delivery acknowledgement timeout 
Enter the time interval, in seconds, to wait for the delivery confirmation. 

• Use revert channel when possible 
Select this option so that a report will be sent via a data revert channel, if 
available. 

 Wi-Fi Report Profile 
This report profile is used to send periodic reports via an IP channel using the 
Wi-Fi module of the radio. 
A single report contains up to 100 coordinate pairs (up to 60 pairs for TRBOnet 
Enterprise 6.1 and older). Please note that this maximum number may decrease 
due to the inclusion of additional data in the report, such as battery status, 
telemetry events, iBeacon location data, and more. 
It is recommended to send a report every 5 seconds. 
 

 EGPS Report Profile 
The Enhanced GPS (EGPS) allows subscribers to make reservations for 
"windows" in which GPS data can be transmitted. Also note that the report may 
contain only compressed iBeacon location data. For all iBeacons, their Major ID 
must be set to 1. 
The table below represents the maximum number of coordinate pairs that can 
be included in the report depending on the window size. 
 
Window size Coordinates 
5 3 
6 6 
7 9 
8 12 
9 15 
10 18 

 
Note that the maximum number of coordinate pairs may decrease due to the 
inclusion of additional data in a report, such as battery status, telemetry events, 
iBeacon location data, and more. 
It is recommended to send a report every 30 seconds. 
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In the EGPS Report page, specify the following options: 
• Window size 

From the list, select the desired window size for Enhanced GPS report. 
• Update interval 

From the list, select the update interval for the window. 
 

 EGPS CSBK Report Profile 
This report profile is used to send periodic reports via MOTOTRBO data channels 
in the following radio systems: IP Site Connect, Capacity Plus Single Site, Capacity 
Plus Multi Site, and Capacity MAX. 
The Enhanced GPS (EGPS) with CSBK data allows subscribers to make 
reservations for "windows" in which GPS data can be transmitted. With this 
report profile, direction and speed won't be added to the report. The 
corresponding option will be disabled in report profile settings. Also note that 
the report may contain only compressed iBeacon location data. For all iBeacons, 
their Major ID must be set to 1. 
It is recommended to send a report every 7.5 seconds. 

 Report Disabled Profile 
This report profile is used to stop sending periodic reports. 

4.5.3 Regions 
The Event Logic rules use geographical regions as input parameters. A region is 
an area selected on the online map and given a unique name. Allowed are 
polygonal regions and circular regions with the maximum radius of 65.00 
kilometers. 
To define regions, click Regions in the Logic section of the navigation panel. 
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In the Presence timeout box, specify the minimum duration of stay within (if 
entered) or out (if left) of the region. This value will be used for Geofencing 
events. 
Regions appear on the map as colored areas. The region names are displayed in 
the right panel. 
The following useful features will help you work with the map: 

To pan the map: 
• Keep the left mouse button pressed and move the mouse cursor to the 

required direction. 

To adjust the scale level: 
• Scroll the mouse wheel to zoom the map. 

To select a different map: 

• Click the Edit Map Configuration button ( ) in the right panel. 
• In the Map Configuration window, from the Tile source drop-down list, 

select the preferred map. 
• Click Apply. 

Note that in the offline mode, the map is loaded from cache. 

To select the cache folder: 

• Click the Edit Map Configuration button ( ) in the right panel. 
• In the Map Configuration window, click the Browse button next to the 

Root cache directory field. Find the destination folder and confirm the 
choice. Or, specify the folder path manually. 

• Click Apply. 
You can perform the following operations with map regions. 

To add a polygonal region: 

• Click the Create Polygonal Region button ( ). 
• Click the map where the region border will start. Draw the shape of the 

region, clicking where you want to place nodes. The added nodes 
connected with lines make a region border. 

• Double-click to finish. The first and the last nodes will be connected with a 
line. The new polygonal region will appear in the right panel under the 
Regions List. 

To add a circular region: 

• Click the Create Circular Region button ( ). 
• Click the map where the center of the region will be located. 
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• Release the mouse button and move the cursor away from the center.  
The distance from the center (in km) is displayed near the region. The 
radius of a circular region is restricted to 65 km. 

• Double-click to finish. The new circular region will appear in the right 
panel under the Regions List. 

To edit a region: 
• Double-click inside the region on the map, or in the Regions List. 

The region on the map is highlighted and all of its nodes are displayed. 
• To drag a node to a different position, click it and keep the mouse button 

pressed. To drop the node, release the mouse button. 
• To delete a node, right-click it. 
• To move the entire region, point to its central point, click and drag it to 

the new position on the map. 
• To save changes, double-click on the map. Or, press Esc to cancel editing. 

 

To import regions: 

• Click the Import from KML button ( ). 
• Confirm to replace all regions. 
• In the Import from KML window that appears browse for the desired 

*.KML file, and click Open. 

To export regions: 
• Select desired regions. 

• Click the Export to KML button ( ). 
• In the Export to KML window that appears locate the folder where you 

want to save the file, type a filename, and click Save. 

To delete a region: 
• Select the region under the Regions List and click the Delete button. 

Note: The deleted region cannot be restored with the Undo 
command. 
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4.5.4 Modules 

 Adding Modules 
This section describes how to add modules. 
To add a module: 

• Click the plus sign icon on the right of the Modules item, and from the 
drop-down list select the desired module. 

 

You can add the following modules: 
• Dynamic Channel Selection 
• Custom Menu 
• Las Known Location 
• Data Forwarding 
• Communicator 
• Hidden Transmission 
• iBeacon Settings 

 

 Dynamic Channel Selection 
The Dynamic Channel Selection module allows for automatic selection of the 
radio zone/channel depending on the geographical region and/or the proximity 
of certain iBeacons. 

• Click the plus sign icon on the right of the Modules item, and from the 
drop-down list select Dynamic Channel Selection 
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In the right pane, specify the following Dynamic Channel Selection-related 
settings: 

• Set default channel 
Select this option and specify the default channel and zone. This 
channel/zone will be automatically set on the radio when its location is 
not available or outside designated regions/iBeacons. 
 Zone 

Enter the default zone. 
 Channel 

Enter the default channel. 
• Lock selected channel 

Select this option so that the radio will prevent the user from changing 
the automatically selected channel. 

• Location priority 
From the list, select the priority to use for Dynamic Channel Selection. 

• Add 
Click this button and specify the following Dynamic Channel Selection 
parameters: 
 Zone 

Enter the zone to be set automatically when the radio stays in the 
selected region and/or in the vicinity of the specified iBeacon(s). The 
value 0 means that the current zone won't be changed. 

 Channel 
Enter the channel to be set automatically when the radio stays in the 
selected region and/or in the vicinity of the specified iBeacon(s). 

 Region 
From the list, select the region within which the radio must stay so 
that the specified channel/zone will be set automatically. 
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 iBeacon: Major ID/ iBeacon: Minor ID 
Specify the Major ID and Minor ID of the beacon(s) in the vicinity of 
which the radio must stay so that the specified channel/zone will be 
set automatically. 

• Delete 
Click this button to remove the selected row from the Channel Selection 
Table. 

 Custom Menu 
The Custom Menu module allows you to replace certain menu items on the radio 
(Contacts, Scan, or Zone) with your own menu items. 
To configure your custom menu: 

• Click the plus sign icon on the right of the Modules item, and from the 
drop-down list select Custom Menu. 

 

In the Custom Menu pane, do the following: 
• Replace radio menu item 

From the list select one of the three radio menu items (Contacts, Scan, or 
Zone) that will be replaced with your custom menu. 

To create a menu item: 
• Select the menu item under which you want to create a submenu and 

click Add. 

 

In the dialog that opens, enter the following: 
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 Menu item icon and text 
From the drop-down list, select the icon that will be displayed in front 
of the menu name. 
In the text box, enter the name of the menu item. 

 Scenario 
From the drop-down list, select the scenario for the menu item. 
If you select 'None', the menu item will only contain submenu items 
and perform no actions. 

Note: Only enabled scenarios will be available in this list. See 
section 4.5.6, Scenarios. 

 Action 
From the drop-down list, select ether to Start or Stop the specified 
scenario. 

 Last Known Location 
In this module you define how to save the radio's current location, also known 
as the last known location. 

• Click the plus sign icon on the right of the Modules item, and from the 
drop-down list select Last Known Location. 

 

 iBeacon Settings 
This module defines iBeacon-related settings that will be used for iBeacon 
Tracking and Security Tokens. 

• Click the plus sign icon on the right of the Modules item, and from the 
drop-down list select iBeacon Settings. 
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iBeacon Tracking 
• iBeacon: Major ID/ iBeacon: Minor ID 

Enter the Major ID and Minor ID (the values or the ranges of values) of 
the iBeacons that will be used for iBeacon-based Tracking. 

• RSSI threshold 
Set the minimum signal strength, in negative decibels, of an iBeacon to 
consider it as discovered. 

• When an iBeacon is discovered 
From the drop-down list, select what to do when an iBeacon is discovered. 
 Do nothing 

This will not add information about a discovered iBeacon to the report. 
 Add to report 

This will just add information about a discovered iBeacon to the report, 
which, in turn, will be sent according to the corresponding report 
profile. 

 Send report normally (selected channel or data channel) 
This will add information on a discovered iBeacon to the report that 
will be sent to TRBOnet in the normal way. If the selected radio channel 
or data channel is busy, the report will be queued up for sending. 

 Immediately send report (selected channel) 
This option means that the corresponding report will be sent to 
TRBOnet immediately on the selected channel. If the selected radio 
channel is busy, the report will be put at the front of the queue. 

 Send report with interrupt (selected channel) 
This option means that the corresponding report will be sent to 
TRBOnet immediately, interrupting the current transmission, if the 
selected radio channel is busy. 
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Note: Use the last two options carefully in order to avoid a high load 
of the radio channel. 

• Level to change iBeacon 
Set the difference in signal strength, in positive decibels, between the 
simultaneously discovered iBeacons that will be used to consider the 
iBeacon with a stronger signal strength as detected by the radio. 

• iBeacon loss timeout 
Enter the timeout, in seconds, within which an iBeacon is not considered 
as lost. 

• When an iBeacon is lost 
From the drop-down list, select what to do when the last of the detected 
iBeacons is lost. 
 Do nothing 

This will not add information about the lost iBeacon to the report. 
 Add to report 

This will just add information about the lost iBeacon to the report, 
which, in turn, will be sent according to the corresponding report 
profile. 

 Send report normally (selected channel or data channel) 
This will add information about the lost iBeacon to the report that will 
be sent to TRBOnet in the normal way. If the selected radio channel or 
data channel is busy, the report will be queued up for sending. 

 Immediately send report (selected channel) 
This option means that the corresponding report will be sent 
immediately on the selected channel. If the selected radio channel is 
busy, the report will be put at the front of the queue. 

 Send report with interrupt (selected channel) 
This option means that the corresponding report will be sent 
immediately, interrupting the current transmission, if the selected 
radio channel is busy. 

• Debug 
Select this option to show debug information on the radio display. 

Security Tokens 
• iBeacon: Major ID/ iBeacon: Minor ID 

Enter the Major ID and Minor ID (the values or the ranges of values) of 
the iBeacons that will be used as security tokens. 

• RSSI threshold 
Set the minimum signal strength, in negative decibels, of an iBeacon to be 
considered as discovered. 
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• iBeacon loss timeout 
Enter the timeout, in seconds, within which an iBeacon is not considered 
as lost. 

• When a security token status changed 
From the drop-down list, select what to do when a token status changes. 
 Do nothing 

This will not add information about a changed token status to the 
report. 

 Add to Report 
This will just add information about a changed token status to the 
report. 

 Send report normally (selected channel or data channel) 
This will add information about a changed token status to the report 
that will be sent to TRBOnet in the normal way. If the selected radio 
channel or data channel is busy, the report will be queued up for 
sending. 

 Immediately send report (selected channel) 
This option means that the corresponding report will be sent 
immediately on the selected channel. If the selected radio channel is 
busy, the report will be put at the front of the queue. 

 Send report with interrupt (selected channel) 
This option means that the corresponding report will be sent 
immediately, interrupting the current transmission, if the selected 
radio channel is busy. 

Note: Use the last two options carefully in order to avoid a high load 
of the radio channel. 

• Debug 
Select this option to show debug information on the radio display. 

4.5.5 Rules 
A rule describes a specific event to which a programmed device will respond with 
a predefined sequence of actions, such as playing back tone or displaying text 
on the radio display, sending text to other radios, changing the radio channel, 
sending alarms, and other. 
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To configure rules, expand the Logic section and click Rules in the left panel. 

To create a copy of a rule: 
• In the left pane, select the rule and click the ellipsis icon on the right side. 

From the drop-down menu, select Add Copy. 
• As a result, a copy of the selected rule will appear in the list of rules. 

To delete a rule 
• In the left pane, select the rule and click the ellipsis icon on the right side. 

From the drop-down menu, select Delete. 
• Confirm the deletion in the dialog box that appears. 

To enable a rule: 
• In the left pane, select the rule and click the ellipsis icon on the right side. 

From the drop-down menu, select Enable. 
Or, in the right pane, select the Enable option next to the rule name. 

To enable the debug mode (if available): 
• In the left pane, select the rule. 
• In the right pane, select the Debug option on the right of the Trigger 

description. 

Note: If the debug mode is selected, the debug information will be 
shown on the radio display when the trigger starts. 
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 Adding a Rule 
To add a rule: 

 

• Click the plus icon on the right of the Rules item in the left pane. 
• From the drop-down menu, select the desired rule type. 
• In the right pane, configure the desired trigger settings (1), conditions (2), 

and actions (3) for the rule. 

 

 Triggers 
The following table summarizes information about all supported triggers and 
their configurable properties. 
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Trigger Description 

Man Down This trigger starts when the radio tilt exceeds the threshold angle 
for a time longer than the pre-alarm duration. 

 Threshold angle: The minimum vertical angle, in degrees, at 
which the radio is still considered up. 

 Pre-alarm duration: The timeout (seconds) after detecting 
the radio tilt. 

Note: Before enabling this event, you need to set a custom axis 
orientation of the accelerometer. This is done by clicking 
Set a custom axis orientation of the accelerometer in the 
Service page. 

No Movement This trigger starts when the radio acceleration is below the 
threshold for a time longer than the wait time. 

 Acceleration threshold: The minimum acceleration at which 
the radio is still considered to be at normal speed. 

 Wait time: The timeout, in seconds, that starts after the radio 
acceleration has fallen below the threshold. 

Lone Worker This trigger starts when there is no user activity for a time longer 
than the response time. The timer will restart after pressing any 
radio button or knob. 

 Response time: The timer, in seconds, that restarts after a 
button push, a talk, or use of the channel selector was 
detected on the radio. 

Speed Limit This trigger starts when the measured speed exceeds or falls 
below the threshold. 

 Speed: The math operator. Values: greater than, less than. 
 Threshold: The maximum or minimum allowed speed in 

kilometers per hour. 

Note: The speed measurement error may be as high as 5 to 10%, 
depending on the type of a two-way radio (less for mobile, 
higher for portable) and on the satellite signal reception 
quality. 

Sudden Acceleration This trigger starts when the radio acceleration experiences a 
sharp change along the given axis. This trigger can be used, for 
example, to detect hard braking of the vehicle. 

 Axis: Select the axis along which to detect the sudden change 
of acceleration. 

 Acceleration threshold: The maximum acceleration that 
shall be exceeded to trigger the event. 
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Trigger Description 

Rollover This trigger starts when the mobile radio tilt exceeds the 
threshold angle for a time longer than the pre-alarm duration. 

 Threshold angle: The minimum vertical angle (in degrees) at 
which the radio is still considered up. 

 Pre-alarm duration: The timeout (seconds) after detecting 
the radio tilt. 

Note: After installing the radio in the working position in a car, 
you need to set a custom axis orientation of the 
accelerometer. This is done by clicking Set a custom axis 
orientation of the accelerometer in the Service page. 

Crash Detection This trigger starts when the radio acceleration exceeds the 
impact threshold, the speed drops to zero within the idle timeout, 
and then there is no movement for the duration of the wait 
timeout. 

 Impact acceleration threshold: The maximum acceleration 
that shall be exceeded to suspect a car crash. 

 Wait timeout: The timeout, in seconds, that starts after the 
suspected car crash and during which no acceleration 
measurements are taken. 

 Acceleration threshold: The minimum acceleration that 
must be gained during the control time to confirm the 
normal speed mode. 

 Idle timeout: The timeout, in seconds, that starts after the 
wait timeout. 

Device Started This trigger starts when the radio is turned on. 

Radio Button This trigger starts when the designated radio button is 
pressed/released. 

 Button: Select the radio button. 
 Action: Select the type of action. This can be ‘Short press’, 

‘Long press’, or ‘Release’. 

Radio Channel This trigger starts when the active channel/ zone is changed on 
the radio. 

 Zone: Enter the zone number. 
 Channel: Enter the channel number. 

CapMax Site ID This trigger starts when the radio registers on a CapMax site with 
a specified Site ID. 

Radio Call This trigger starts when an incoming or outgoing call starts, or a 
call (either incoming or outgoing) ends. In addition, you can 
select the call type for this event. 

 Call trigger: Select one of the three triggering conditions. 
 Call type: Select one of the call types. 
 Radio/Group ID: Enter the ID of the radio/radio group if the 

call type is Radio/Radio Group. 

Telemetry Input This trigger starts when the status of any I/O pin has changed on 
the device. 

 Telemetry: Select the Input pin #. 
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Trigger Description 

 Trigger: Select the type of change occurring to the pin 
(turned on, off or toggled) 

Geofencing This trigger starts when the radio enters/leaves the selected 
region for a time longer than the presence timeout (see section 
4.5.3, Regions). 

 Region: Select the region the borders of which are 
monitored. 

 Direction: Select if the region is entered or left. 

Swift Command  This trigger starts when the radio receives the Swift 
command. 

Wi-Fi Network This trigger starts when the radio is connected/disconnected 
to/from Wi-Fi network for a time longer than the wait timeout. 

 Network trigger: Select whether the Wi-Fi network is 
connected or disconnected. 

 Wait timeout: Enter the minimum duration of staying 
connected/disconnected. 

iBeacon This trigger starts when the radio enters/leaves the coverage 
zone of the selected iBeacon. 

 iBeacon: Select whether the iBeacon is found or lost. 
 Major ID: Enter the beacon’s major ID exactly as specified in 

the iBeacon device. 
 Minor ID: Enter the beacon’s minor ID exactly as specified in 

the iBeacon device. 

Security Token This trigger starts when one of the following Security Tokens 
event has occurred: 

 User Logged In 
 User Logged Out 
 Token Not In Range. 

Telemetry Command This trigger starts when the radio receives the telemetry 
command. 

 Target: Select the VIO number. 
 Command: Select the telemetry command. 

 

 Conditions 

Note: Adding conditions to a rule is optional. If you add multiple AND 
conditions, ALL OF THEM must be TRUE for the actions to be 
executed. If you add OR conditions, at least one of them must 
be TRUE. 

To add a condition: 
• In the left pane, select the rule. 
• In the right pane, select Conditions and click the plus icon on the right. 
• From the drop-down menu, select the desired condition type. 
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 Geofencing 
In the Condition: Geofencing dialog box specify the following 
parameters: 
• Region 

From the drop-down list, select the desired region. 
• Position 

From the drop-down list, select 'Inside' or 'Outside' position in a 
region. 

 Flag State 
In the Condition: Flag State dialog box specify the Flag (a number 
from 1 to 32) and its State (On/Off). 

 Selected Radio Channel 
In the Condition: Selected Radio Channel dialog box, specify the 
Channel and Zone. 

 CapMax Site 
In the Condition: CapMax Site dialog box, specify the Site ID. 

 Telemetry Input State 
In the Condition: Telemetry Input State dialog box specify the 
Telemetry input (Input 1 – Input 8) and its State (On/Off). 

 iBeacon In Range 
In the Condition: iBeacon In Range dialog box specify the iBeacon's 
Major ID and Minor ID. 

To add an AND/OR condition: 
Once you have added the first condition, you may add other conditions by 
clicking the plus icon: 
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• Select Conditions and click the plus icon on the right. 
• Click Add AND Condition or Add OR Condition and from the drop-down 

menu, select the desired condition type. 
A combination of multiple conditions may look like in the figure below: 

 

To edit condition settings: 
• Double-click the desired condition. 

In the dialog box that opens, edit the required condition parameters. 

To delete a condition: 
• Select the desired condition and click the ellipsis icon on the right side. 

From the drop-down menu, select Delete. 

Note: Conditions can also be added to the step of actions. 

 Actions 
If the rule already contains predefined actions: 

• Select Actions and click the plus icon on the right. 
As a result, the new step will appear at the bottom of the list of steps. 

• Click the duration field and specify the step duration, in seconds. 
• Click the plus icon on the right of the selected step. 
 Click Add Action and from the drop-down menu, select the desired 

action. 
 Click Add Condition and from the drop-down menu, select the desired 

condition. For a description of conditions, see section 
4.5.5.3, Conditions. 

Note: Only AND conditions can be added to the step of actions. 

• To edit an action, double-click it, and in the dialog that appears, specify 
the required parameters of the action. 

• To edit a condition, double-click it, and in the dialog that appears, specify 
the required parameters of the condition. 

If there are no predefined actions for the rule, you may add actions with the help 
of Scenarios. 
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• Select Scenarios and click the plus icon on the right. 
 If there are still no scenarios in the list of scenarios, the new scenario 

will be created. 
 If the list of scenarios is not empty, 

click Add start scenario > Create new scenario, 
or select one of the already created scenarios from the list. 

• See above for information on how to edit actions. 
The following table summarizes information about all supported actions and 
their configurable properties. 

Action Description 

Play Tone This action forces the radio to play back the specified tone. 

 Tone: The tone to be played back. 
 Tone Type: Choose whether to play the tone momentarily or 

repetitively. 
 Volume shift: The volume boost (in MOTOROLA’s units of measure). 

Play Announcement This action forces the radio to play back a pre-recorded voice 
announcement. 

 Voice Announcement: Select one of the pre-recorded voice 
announcements. 

Change Volume This action forces the radio to change the volume of its speaker. 

 Action: Select the action to be executed (Increase Volume or 
Decrease Volume). 

Display Text This action forces the radio to display text. 

 Text: Enter the text to display on the radio. 
 Position: The display line from which the text starts. Options: Line 1, 

Line 2, Line 3, Line 4. 
 Alignment: Select the alignment of the text. 
 Font: Select the font style (Normal or Bold). 
 Background: Select the background color for the text. 

Set Display 
Brightness 

This action will set the radio display brightness to a specified level. 

 Brightness: Select one of the options: 'Increase' (one step), 
'Decrease' (one step), 'Maximum', 'Minimum' or 'Default'. 

Set Power Level This action will set the radio’s transmission power level for the current 
channel. 

 Power: The values are 'Low' and 'High'. 

Set Radio Channel This action forces the radio to select a different radio channel/zone. 
Properties: 

 Zone: The zone to be set. 
 Channel: The radio channel to be set. 

Note: These are numerical values that are represented in MOTOTRBO 
CPS, Channels>Zone>Channel (in the Position column). 
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Action Description 

Change Radio 
Channel 

This action forces the radio to change the radio channel: 

 Increment Radio Channel 
 Decrement Radio Channel 

Set Telemetry 
Output 

This action will set the selected telemetry output to the specified state. 

 Output: Select the radio's output to perform the specified action on. 
 Action: Select the action for the output (Toggle, On, Off). 

Press Button This action will short-press the specified Accessory Button on the radio 
(No Dot Button, 1-Dot Button, or 2-Dot Button). 

 Short press: Select the desired Accessory Button. 

Lock Controls of 
Radio 

This action will lock/unlock the radio's keyboard. 

Manage Emergency This action activates/deactivates the alarm mode on the radio. 

Send Text (TMS) This action forces the radio to send text to a specified radio or radio 
group. 

 Text: The message to be sent. 
 Destination: The recipient of the message. Values: radio, radio 

group. 
 Radio ID: The radio ID of the recipient. 

Send Report This action will send a report to TRBOnet Server. 

 Priority: 
o High (selected channel) 

The report will be sent immediately over the selected channel. If 
the selected radio channel is busy, the report will be put at the 
front of the queue. 

o With Interrupt (selected channel) 
The report will be sent immediately over the selected channel, 
interrupting the current transmission, if the channel is busy. 

Send Swift 
Command 

This action will send a Swift command to TRBOnet Server. 

 Command: Select the Swift command to be sent. 
 Parameter: Enter the parameter if the Swift command contains a 

parameter. 
 Destination: Select one of the destinations (TRBOnet, Radio, or 

Radio group). 
 Radio/Group ID: Enter the Radio/Group ID if the Radio or Radio 

group are selected as the destination. 
 Target Device: Select the device connected to the target radios: an 

option board (Swift OB, GOB) or a DT series controller (Swift DT200/ 
DT600). 

 Priority: Select either 'Immediately send to TRBOnet' or 
'Immediately send to TRBOnet with interrupt'. The latter option 
means that the selected command will be sent immediately, 
interrupting the current transmission, if the radio channel is busy. 
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Action Description 

Send DTMF This action will force the radio to send the specified DTMF sequence on 
the radio channel. 

 Sequence: The sequence of digits to be sent. 
 Pretime: The duration of silence (ms) prior to sending the first 

DTMF tone. 
 Duration: The duration of the DTMF tone digits in milliseconds (ms). 
 Interval: The duration of the intervals between the DTMF tone digits 

in a transmission sequence in milliseconds (ms). 

Send Swift Alarm This action will send the corresponding Swift alarm (Man Down, No 
Movement, etc.) to TRBOnet Server. 

Select Report Profile This action will force a device to use the specified profile with report 
settings. 

Note: A profile with report settings defines rules for sending reports to 
TRBOnet Server. See also section 4.5.2, Report Profiles (page 13). 

 Profile: Select the report profile to switch to. 

Set Flag This action will set the selected flag to the specified state. 

 Action: Select the action for the flag (Toggle, On, Off). 
 Flag: Specify the flag (a number from 1 to 32). 

Log Out User This action will log out the user (deallocate the radio). 

Manage Scenario This action will start/stop the desired scenario. See section 
4.5.6, Scenarios. 

 Scenario: Select the desired scenario. 
 Action: Select either to Start or Stop the desired scenario. 
 With delay: Specify the delay, in seconds. 

Add Trigger to 
Report 

This action will add the corresponding trigger (Man Down, No 
Movement, etc.) to the report. 

 
 

4.5.6 Scenarios 
A scenario is a sequence of steps/conditions/actions that can be then 
started/stopped in a particular place of a rule by clicking 
Add Action > Manage Scenario. 
To configure scenarios, expand the Logic section and click Scenarios in the left 
panel. 
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The Scenarios pane displays a set of the scenarios. You can manage the 
scenarios as described below. 

To create a scenario: 
• Click the plus icon on the right of the Scenarios item in the left pane. 

As a result, the new scenario will appear in the list of scenarios. 

 

• Select a scenario in the left pane. In the right pane, specify the following 
parameters: 
 Run scenario cyclically 

Select this option so that the scenario will run cyclically until stopped. 
 Restart scenario when Start command is repeated 

Select this option so that the scenario will be restarted from the 
beginning when the Start command is repeated during the scenario 
execution. 

• Select Actions and click the plus icon on the right to add a step. 
For more details on editing actions, see section 4.5.5.4, Actions. 

To create a copy of an existing scenario: 
• In the left pane, select the scenario and click the ellipsis icon on the right 

side. 
From the drop-down menu, select Add Copy. 

• As a result, a copy of the selected scenario will appear in the list of rules. 
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To edit a scenario: 
• Double-click the scenario or select it in the list and click Edit. 

To delete a scenario: 
• In the left pane, select the scenario and click the ellipsis icon on the right 

side. 
From the drop-down menu, select Delete. 

• Confirm the deletion in the dialog box that appears. 
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4.6 Mass Configuration 
You can configure multiple option boards at once by using the Mass 
Configuration mode. The OTA connection is used for over-the-air programming 
of endpoint devices such as DT500 connected to a MOTOTRBO radio or an option 
board ST002 installed into a MOTOTRBO radio. 

• On the toolbar, click Tools > Mass Configuration. 

 

• In the Mass Configuration page, enter the following parameters: 
 Device type 

From the drop-down menu, select either 'Swift OB, GOB', 'Swift DT500' 
or 'Swift DT200/ DT600'. 

 OTA Connection 
In this section, specify the OTA (over-the-air) Connection-related 
settings. 
• Gateway 

The gateway that can establish an IP connection with TRBOnet Swift 
CPS and that can communicate with the device over the air. 
Values: TRBOnet Server, Swift IP Gate: Swift A100/ A200 

• IP address 
The IP address of the gateway selected above. 

• Port 
This is the Forward Data service port of the TRBOnet Server (if 
selected above). Default: 4011. 
To get the port number, launch the TRBOnet Enterprise (PLUS) 
Server application and select Radio Systems > Services in the left 
pane. Find the port number under the Forward Data service 
option. Also make sure that the Forward Data service option is 
selected. 
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• Response timeout 
The time period, in seconds, to wait for a response from the server 
side (TRBOnet Server, Swift IP Gate). 

 File 
Enter the full path name for the configuration file (*.swr) that will be 
sent to the radios specified below. 

 Radio ID range 
Enter the range of Radio IDs to which the configuration file selected 
above will be sent. 

Note: Separate each Radio ID with a comma, for example, 
"105,106,111", or enter the range using the following 
example: "105-111". 

 Retry count 
Enter the number of retries allowed. 

• Once you have specified the desired configuration settings, click Start. 
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5 Licensed Features 
To learn the statuses of all licensed features on a device, connect the device to 
your computer and read the configuration of the device in TRBOnet Swift CPS. In 
the left panel, click Device and License Information. 

 

In the right panel, all the licensed features that are supported by your device are 
marked as Activated, Available for activation, or Not available (not supported 
on your type of device). 

• The Location Tracking license item allows the option board to receive 
GPS and iBeacon location data from the radio. 

• The Personal Safety license item allows the option board to receive 
G-meter data from the radio. 

• The Voice Recording license item allows the option board to receive voice 
recording data from the radio. 

5.1 Activating Features 
To activate features on a device: 

 Click Activate features. 
 In the Activate features window, enter the license key. 
 If the license key is valid, the Activate features window displays all 

features included into the license. You can learn how many times each 
feature was activated on different devices using this license, and how 
many more activations are allowed. 

 Click the Activate features button. If this button is unavailable (grayed 
out), your device works in the demo mode. Click the Restore features 
button to return to the normal mode and activate all purchased features 
on the device. 
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Note: When you choose the demo mode and then the normal mode on a 
device, the license counter is not incremented. 
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